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C3D Protocol Phases 
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C3D Protocol Phases 

 C3D Protocol is typically organized in the 
following Phases 
 Screening/Baseline 
 Courses/Cycles 
 Ongoing 
 Labs 
 Off Treatment/Off Study 

 Each Phase contains one or more visit within  
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Standard Forms 

 Library of Standard Forms & Rules is available 
as a starting point to build protocol specific 
forms & rules 

 Each Form contains mandatory and derived 
fields 

 Detailed Instructions are available for each 
Standard Form 
https://ccrod.cancer.gov/confluence/x/9QiJAw   

https://ccrod.cancer.gov/confluence/x/9QiJAw


Standard Forms 

 Screening Baseline Forms 
 Enrollment, PE, Vitals, Symptoms, Prior Tx, … 

 Courses/Cycles 
 Course Initiation, Tx Administration, PK, Course 

Assessment, PE, … 
 Ongoing 
 AE, Concomitant Measures, Extent of Disease, … 

 Labs 
 Blood Chemistry, Hematology, … 

 Off Tx / Off Study / Follow-Up 
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eCRF Instructions 
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eCRF Instructions 

 Detailed Instructions are provided for Standard 
Forms including 
 Screen Shot 
 General Description 
 Field Specific Description (Mandatory, Derived, etc.) 
 Validation/Derivation Rules 

 

 Quick Tip: 
 Protocol Specific Forms and Rules may have minor 

deviations to accommodate for protocol requirements. 
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C3D Web Site 

Login Button 
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C3D Web Sites 

 Internal (Within NIH LAN) 
http://ccrtrials.nci.nih.gov/CCR_trials/C3DS/C3D_Users_Login 

 External (Outside NIH Firewall) 
https://octrials.nci.nih.gov/opa45/rdclaunch.htm 
 

 Quick Tip:  
 C3D provides a separate Data Entry environment to test protocol 

design 
 

 

http://ccrtrials.nci.nih.gov/CCR_trials/C3DS/C3D_Users_Login
https://octrials.nci.nih.gov/opa45/rdclaunch.htm


C3D Support 
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Support Contact 
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C3D Support 

 Contact 
 Email: ncicbiit@mail.nih.gov 
 Phone: 240-276-5541 

 CBIIT provides the first line of support for C3D 
related issues 

 Protocol specific issues are escalated to the 
Protocol Builder by CBIIT 

 Changes to Standards are escalated to Controls & 
Configuration Management Group (CCMG) 

mailto:ncicbiit@mail.nih.gov
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Login 

Enter User, Password, and Database  
Click Connect 
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Username & Password 

 Username is of the format ops$smiths 
 Password has to be 8 characters starting with 

a letter and containing at least one number 
and one special characters (e.g. ! # ) 

 Production Database is called ocprod 
 About C3D Password 
 Do not share the password with others! 
 Password needs to be changed the first time you login 
 Passwords expire every 6 months and need to be changed 
 Account gets locked upon three unsuccessful attempts 
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Selecting Activity 

Select All Data, Active 
Discrepancies, etc. 

Choose Different Studies 

Specify Search Criteria 

Select Data for specific 
Site or Patient 

Study Summary 
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Selecting Activity 
 Quick Link to View 
 All Study Data 
 Discrepant Data 
 Site Specific or Patient Specific Data 

 Choose a Different Study 
 Access to studies is controlled by user role 
 Default Study is preserved from prior login 

 Specify Search Criteria 
 

 Quick Tip:  
 This screen provides a quick review of open discrepancies 

in your study 
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Selecting Study 

Select Study & Click OK 



Study Access 

 Study Access is provided by User 
 Types of Access 
 Data Managers 
 Research Nurse 
 Monitor 
 Principal Investigator 
 Reviewer 
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Search Criteria 

Search Criteria Dialog Box 
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Search Criteria 
 Search options: 

 Book - collection of CRFs in the protocol/amendments 
 Site 
 Patients 

 Range of Patients 
 Visits/Pages 

 Phases, Visits, etc. 
 CRF Status 

 Complete, Discrepant, Verified, Approved, etc. 
 CRF Entry Date Window 

 Entry or Modification Date Ranges 
 Data 

 
 Quick Tip:  

 Protocol Amendments may require different DCI Book.  Use Search option 
to pick the appropriate book. 

 Search Criteria Could be saved for future use. 
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RDC Spreadsheet 

Patients down the left An Icon indicates the eCRF for 
the corresponding patient 

Visit tabs across the top 

Information specific to eCRF 

Phases or Visits Pull Down for additional Visits 

Active Filter 

eCRF within a visit 
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Navigating RDC Spreadsheet  
 Spreadsheet Layout  

 Patients along Rows 
 Visit Tabs along Columns; pull down for additional visits 
 eCRF within Tabs 
 Cells represents an eCRF for the corresponding Patient-Visit 

 Tabs can be organized by Study, Phase, & Visit 
 Information Tabs for Summary, Discrepancies, Verification, 

Audit-trail, etc. at the bottom 
 Navigation Functions via 

 Menu 
 Toolbar 
 Hot Keys 
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eCRF Icons 
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Important eCRF Icons 

 Square icon represents manual entry 
 Round icon represents automated entry (lab load) 
 An eCRF just created, but without data has no lines 

within the icon 
 Partially entered eCRF has lines across half of the 

icon 
 Completed eCRF have lines across the whole icon 
 Blank Square icon indicates eCRF has been marked 

blank 
 Red icon indicates one or more open discrepancies 
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Electronic CRF (eCRF) 

Tabs for sub forms Non-enterable field 

Yellow – Univariate 
Discrepancy 

eCRF Scroll Bar 
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eCRF Navigation 

 Clicking on eCRF icon brings up the eCRF 
 eCRF may contain sub-tabs 
 Grey Fields indicates non-enterable fields 

(Derived, Defaulted, etc.) 
 eCRF Scroll Bars indicate additional 

information 



27 

Audit Trail 

eCRF specific Audit Trail 
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Audit Trail 

 Audit Trail Tab shows history of all changes 
made to a specific eCRFs 

 Shows current and prior values for each 
changed eCRF field along with the date of 
change and the user who made the change 
 

 Quick Tips: 
 Auditing Begins after Form is marked complete 
 Do not share user ids and passwords! 
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Resizing eCRF Window 

Double Click Title Bar to Resize 
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Resizing eCRF Window 

 Click on the eCRF title bar 
 Click and drag title bar to move window 
 Click and drag window edge to expand/ 

reduce window size 
 Click OK when Done 

 
 Quick Tip:   

 Right mouse click on the eCRF title bar to show a pop-up menu 
with options to move/resize the eCRF window. 
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Log Out 

Log out using Exit 



Log Out 

 Exit C3D before closing the Browser 
 Inactivity for more than 30 minutes logs your 

out automatically 
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Inserting New Patient 

Icon to Insert New Patients 

Choose Patient Number 
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Inserting New Patient 

 Click Patient Icon or Select Insert -> Patient from the 
menu bar 

 Choose a Patient Number from the pick list 
 New Patient Row is Created 

 
 Quick Tips:  
 The total number of Patients available for entry are 

governed by protocol ceiling accrual.  Request additional 
patient numbers if protocol is amended. 

 It is a good practice to use the patient numbers in sync with 
those assigned by Central Registration Office (CRO) 
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Starting New Planned eCRF 

Click on Cell to Insert eCRF 



Starting New Planned eCRF 

 Click on cell to insert eCRF 
 Resize if necessary   
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Entering eCRF Header 

Enter Visit Date and press Tab key 
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Entering New eCRF 
 Click on the empty Cell to insert appropriate eCRF 
 Visit Date is mandatory for most forms  
 Interpret as Evaluation Date, Administration Date, Initiation 

Date, Lab Date, etc. 
 Use t for today, y for yesterday, or enter date in the 

MMDDYYYY format. 
 Partial dates are not acceptable when a visit date is 

mandatory 
 

 Quick Tip:  
 Visit Date can be left Blank for Ongoing forms such as AE, 

Conmeds, etc. 
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Entering Data in eCRF 

Tabs for sub forms 

Indicates Pick List 

Non-enterable field 

Use Tab to move between fields 

Yellow – Univariate 
Discrepancy 

eCRF Scroll Bar 
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Entering Data in eCRF 

 Navigating between Fields 
 Use Tab Key to move to Next Field  
 Use Shift Tab to move to Previous Field 
 Use Mouse Click to navigate to a Specific Field 

 Fields with Ellipsis indicate a Pick List (Use the Pick 
List!) 

 Enter Dates as 
 MMDDYYYY for Current Information 
 MMYYYY for Prior Information is acceptable when 

complete date cannot be obtained 
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Tabular eCRF 
To Delete a Single Row 

Number of Repeats and Repeats 
to Display are set by Designers.  
Scroll Using Up/Down Arrow 
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Tabular eCRF 

 Fields shown in a grid layout 
 Scroll up and down the rows of the table using arrow 

keys (No Scroll Bars!!) 
 
 Quick Tips: 
 Use the menu option CRF -> Insert Row to insert a row 

between two rows (below the currently selected row).  
 A row cannot be left blank and must be deleted before 

proceeding to another row. Select the menu option CRF -> 
Delete Row. 
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Using Pick List 

Click Ellipsis or Hit F9 for Pick List 
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Using Pick List 

 Fields with Ellipsis contain a Pick List 
 Pick List can be accessed by clicking the Ellipsis or 

Entering the F9 Key 
 Pick List is Sorted Alphabetically and gets shorter as 

characters are typed in. 
 

 Quick Tips:  
 Pick Lists with more than 1000 entries needs to be queried 

differently. (Demo) 
 If a value is not in the pick list enter it, create a 

discrepancy, and consult your DM Supervisor. 
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Marking eCRF Blank 

Marking Section Blanks 

Marking entire eCRF Blank 
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Marking eCRF Blank 

 Entire eCRF can be marked Blank 
 Sections of eCRF can be marked Blank 
 Checking Blank Flag will erase any entered 

information from the eCRF/Section 
 Blank Flag can be unchecked to enter information 

 
 Quick Tip:  
 It is a good practice to mark Sections not entered as 

Blanks so that the overall status of the eCRF is marked 
Completed. 



Entering/Viewing Laboratory Data 
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Add Unplanned 

Show/Hide Unplanned 



Entering/Viewing Laboratory Data 

 Laboratory Data eCRFs are designed with 
dedicated Tabs 

 Additional Forms can be viewed by clicking 
Show Unplanned Events 

 Additional Forms can be added by choosing 
menu option Insert -> Visit 
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Saving eCRF 

Save Icon 
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Saving eCRF 

 eCRF can be saved using  
 Save Icon 
 F10 Key 
 File -> Save menu option 

 
 Quick Tip:  
 Save Often!! Especially while entering Ongoing 

Information such as AEs and ConMeds. 
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Data Entry Change Reason 

Data Changed 
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Data Entry Change Reason 

 Change Reason needs to be specified while 
changing data on completed eCRF 

 Change Reason becomes part of the Audit Trail 
along with date of change and user name 

 Comments can be provided in the change reason to 
further explain 
 

 Quick Tip:  
 Do not use personnel names in the comments. 
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What is a Discrepancy? 

 A discrepancy is the failure of entered data to 
pass a validation check as applied by C3D 

 C3D validation checks are defined based on 
the definition of the fields, logical rules, 
protocol specifications, and sponsor 
requirements. 
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Why Discrepancies? 

 Discrepancies are tools to assist teams in 
programmatically identifying potential data 
inconsistencies  

 Discrepancies facilitate real-time QA of clinical data 
 

 Quick Tips: 
 Discrepancies do not cover 100% of possible data 

inconsistencies. 
 Clinical judgment may supersede discrepancy logic. 
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C3D Discrepancy Types 

 Univariate 
 Generated during data entry/load when data is in some 

way different from the Question definition (e.g. length, type, 
range, pick list, etc.) 

 Multivariate 
 Based on a condition on one or more fields as defined in a 

validation rule 
 Generated on-line or when validation rules are run 

 Manual 
 Generated by data entry operator seeking clarification on 

data values 
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Some Typical Discrepancies 

Types Resolution 

Data Type Review Source Document 

Length Problems Use NIH accepted Abbrev 

Missing Pick list Values Search for alternates, e.g. Generic; Consult TL/Liz. 

Mandatory Value Refer to Source Document;  Design modification 

Partial/Invalid Dates Refer to Source Documents; Check Day Month 
Year order; Check that date is not in the future. 
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Outstanding Discrepancies in a Study 



58 

Outstanding Discrepancies in a Study 

 Total number of Discrepancies in a study are 
shown in the activity list 

 Clicking on the ‘Review xx Active 
Discrepancies” will present only the 
Discrepant eCRFs 
 

 Quick Tip: 
 Data Managers should manage their 

discrepancies every morning to help ongoing QA 
of clinical data. 
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eCRFs Containing Discrepancies 

eCRF Containing Unreviewed 
Discrepancies are displayed as Red 



eCRF Containing Discrepancies 

 eCRF containing discrepancies are shown in 
Red 

 It is a good practice to address discrepant 
eCRF on an ongoing basis 
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Discrepancies Tab 

Discrepancies in the selected eCRF are 
summarized in Discrepancies Tab 

First sub-tab enumerates all discrepancies 
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Discrepancies Tab 

 While viewing an eCRF, clicking on the 
Discrepancies Tab shows the discrepancies 
on that eCRF 

 The first sub-tab gives the summary of all 
discrepancies in that eCRF (open and 
closed) 
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Discrepancy Details 

Each Discrepancy Detail is in following sub-tab 

Disc History is available via this button 



64 

Discrepancy Details 

 Subsequent sub-tabs show details for each 
discrepancy 

 Open Discrepancies are displayed first and 
are followed by Closed Discrepancies 
 

 Quick Tip: 
 Double Clicking on the Discrepancy Text brings 

up a pop-up box with the entire message 
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How are Univariate Disc. Created? 

Univariate Disc Pop-up 

Description 

Operator can cancel to not 
create the discrepancy 

Alternatively, operator can 
accept to create univariate disc 
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How are Univariate Disc. Created? 

 Univariate Discrepancies pop-up is presented during 
data entry when the entered value does not match 
the field definition 

 Data Entry operator can  
 Cancel the pop up and fix the value 
 Or accept the discrepancy 

 
 Quick Tip: 
 Univariate Discrepancies are reassessed during Batch 

Validation for Design Changes. 
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How is a Univariate Disc. Displayed? 

Data Values with Univariate 
Discrepancies is highlighted 

Data Values with Univariate 
Discrepancies is highlighted 
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How is a Univariate Disc. Displayed? 

 Discrepant data is highlighted in Yellow 
 Discrepancy text provides the details 

 
 Quick Tip: 
 Double Click on the Discrepancy Message Text to 

view the entire message in a window. 



How are Multivariate Disc. Created? 

 Multivariate Discrepancies are created based on 
validation rules programmed in a study 
 Example 1: Create Discrepancy if the entered BSA is not 

within 10% of the calculated BSA 
 Example 2: Create Discrepancy if Date of Histological 

Confirmation is before Date of Diagnosis 
 

 Quick Tip: 
 Rules available as a standard on each eCRF are 

summarized in the eCRF instruction manual. 
 Though several standard rules are implemented for each 

eCRF as specified on the eCRF instructions manual, 
clinical teams can request them to be turned off if they do 
not apply to a protocol. 
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Evaluation of Multivariate Rules 
 Validation Rules are evaluated  
 on-line upon completion of a form, or  
 during an overnight batch validation session 
 

 Quick Tip: 
 Complex rules run overnight 
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How is a Multivariate Disc. displayed? 

Discrepancy Description 

Discrepancy Subtab 

Clinical Data 
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How is a Mulitvariate Disc. displayed? 

 Discrepancy is based on one or more fields and is 
NOT highlighted in Yellow 

 Discrepancy sub-tab provides the details 
 Discrepancy Text 
 Involved Clinical Data in the evaluation of the Discrepancy 

 
 Quick Tip: 
 The Action pull-down “Go to Data Field” does not work as 

the discrepancy could be based on more than one field. 



How to Address a Discrepancy 
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Choose Go to Data Field from Pull Down Menu 

Fix Data as indicated in the Discrepancy Text 
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How to Address a Discrepancy 

 Review Discrepancy Text 
 Whenever possible, use the Action pull down ‘Go to 

Data Field’ to jump to the Discrepant Field 
 Resolve the discrepancy by: 
 Modifying incorrect data and specifying change reason 
 Requesting Design or Rule Change 

 Quick Tip: 
 System obsoletes the discrepancy automatically when data 

is corrected. 
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Verification & Appoval 
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Verification & Approval 

 C3D Verification & Approval functionality offer 
capability to track QA and Monitoring of 
eCRF 
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Verification 

Verify Button 

Verification Tab 
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Verification 

 Each eCRF can be verified by clicking on the 
Verify button 

 Verified eCRF Icon has a Checkmark 
 Editing a verified eCRF changes its icon to a 

Re-Verify status 
 Edited eCRF can be re-verified 
 eCRF Verification Change History is 

maintained in the Verification Tab 
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Verification 

Verified eCRF 

Re-verification 
Required 
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Verification 

Re-verify Button 
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Approval 

Approval Password 

Approved 

Verified & Approved 

Re-Approval required 

Approval Tab 
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Approval 

 Each eCRF can be approved by providing the 
C3D Password on the Approval Tab 

 Approved eCRF Icon has a Signature 
 Editing an approved eCRF changes its icon 

to a Re-Approve status 
 Edited eCRF can be re-approved 
 eCRF Approval Change History is maintained 

in the Approval Tab 
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CRIS to C3D Lab Data Flow 

CRIS CDW C3D 

Lab Mapping 
---------------- 
WBC Count  WBC_SERUM 
Basophils BASO 
Hemoglobin HEMOGLOBIN 
WBC Morphology  ??? 
--- 

LLI 
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What is LLI? 

 LLI is a utility to review and identify specific 
Lab Test Results to be downloaded from the 
CRIS/CDW into C3D 

 URL: 
http://octrials.nci.nih.gov/opa45/labloadinter.htm 

 Username & Password are same as C3D 

http://octrials.nci.nih.gov/opa45/labloadinter.htm
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LLI Search Screen 

Search Criteria 

Selected Panels 

Action Buttons 

Workflow 
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LLI Search Criteria 

 
• Searching 

– Can search by Study, Patient Number, Lab Panel, OC Lab Question, 
Date and/or Time 

• Each search field contains Pick List. 
• Date and Time allows the ‘%’ wild card 
• Date and Time provide the additional option of: 

• “On or Before”, “On or After” and “LIKE” comparisons 
• Partial dates can be entered as %NOV% 
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LLI Search Screen Results 

• Search Results 
– The result set lists Lab Panels that have at least one lab test available 

for loading that meet the criteria entered into the search fields. 
– The sort order can be changed using the column headings. 
– Results can be selected/deselected for processing by using the 

individual select check box or Select Buttons.  
– Entire panels of lab tests can then be moved to the Load Cart or Marked 

for Archive. 
– Clicking  “View All…” button or by double clicking the record presents 

the Work Cart with specific Lab Test Results for that panel. 
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LLI Work Cart 

• Work Cart 
– Shows Entire Panel, including previously loaded and missing Lab Tests 
– The list can be filtered using the “Load Flag” radio buttons. 
– Sort by Lab Test Panel Order (R), Test Name, Results, etc. 
– Results can be selected/deselected for processing by using the 

individual select check box or Select Buttons.  
– Once selected, the lab tests can be moved to the Load Cart or Archived 
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